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Spectral Mapping Using Clementine UV-Visible-NIR Data Sets: Applications to
Lunar Geologic Studies

Richard Evans, Christian Wöhler, Raffaello Lena
Geologic Lunar Research (GLR) Group

Spectral properties
The Clementine lunar probe imaged the lunar surface using five UV-visible spectral
bands and six near infrared bands covering the wavelength range from 415 nm to 2780
nm. The five UV-visible bands have been available on the map-a-planet website
maintained by the USGS for some years. Recently, however, the first four near infrared
bands covering the range from 1100 nm to 2000 nm have been calibrated so that both
datasets can be used seamlessly. Calibration for the last two near infrared bands (2600
nm and 2780 nm) is generally thought to be less reliable.
Examination of wavelength vs reflectance plots made from the 415 nm to 2000 nm
calibrated images provides important information about the mineral composition of the
moon. Information about the identity of iron bearing (mafic) minerals (orthopyroxenes
and clinopyroxenes) is contained in the band center, depth and width parameters of an
absorption trough near 1000 nm. In some cases secondary absorption features due to the
presence of an olivine or impact melt glass component are present at higher wavelengths.
The band center, depth and width parameters of these secondary features are useful in
analyzing mineral content. In addition, pyroxenes have a shallow secondary trough at
about 1250 nm, however analysis of this trough was excluded from the present paper.
The continuum slope, generally taken as the slope of a line connecting the reflectance
value at 750 nm and 1500 nm, is steeper for more mature (i.e. weathered) lunar features
and shallower for more recent, less weathered lunar features. This slope can be used to
correct the depth of the mafic absorption trough near 1000 nm for the effects of
weathering by micrometeorite bombardment and long term exposure to solar radiation.

Abstract
This paper explores the automated production of maps of spectral parameters of lunar
features using the Clementine UV-Visible-NIR data set covering the wavelength range
between 415 nm and 2000 nm. Maps were produced independently using both GNU Oc-
tave and Microsoft Excel 2007. Maps were made of a) the band center minimum and
depth of the principal mafic absorption trough near 1000 nm for both orthopyroxenes
(890 to 945 nm) and clinopyroxenes (950 to 1000 nm); b) the band center minimum and
depth of any secondary absorption feature present at higher wavelengths (1005 to 1095
nm); c) the FWHM (full width at half maximum wavelength) of the principal absorption
feature; and an Optical Maturity (OMAT) map. Olivine deposits were differentiated
from impact melt deposits through use of a 1500nm/2000 nm ratio image which shows
olivine features as bright pixels.
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Weathering causes the absorption trough to become shallower and less deep.
The trough characteristics can be restored by dividing reflectance values by the
continuum slope.
The maturity of a lunar feature on Clementine PDSMAP images (which have been

calibrated to the standard Apollo 16 soil sample #62231 by the John Adams method can
be mapped using the OMAT or optical maturity value where:

OMAT = [ (R750 – 0.04)2+ (R950/R750 – 1.22)2 ]0.5

The PDSMAP image grayscale values are first converted to absolute reflectance by
multiplying by 0.000135. OMAT values have been directly related to crater age. The
larger the OMAT value, the more recent and less mature the lunar feature. In Fig. O-1 of
Copernicus below, the central peak material is newer and fresher than the mare material
(OMAT values of roughly 0.35 vs 0.2).

If the OMAT values of the central peaks and the adjacent mare were the same, this would
have implied that the crater was the same age as the adjacent mare. Similarly, comparing
Fig. O-1 and Fig. O-2, it is clear that Aristarchus is a much younger crater than
Copernicus (OMAT value of 0.5 vs 0.35 for the central peak area) and that Aristarchus
crater is younger than the adjacent terrain.
Copernicus is estimated to be 810 million years old.

Aristarchus is estimated to be about 450 million years old. Because of the complications
in spectral interpretation introduced by the maturation process, mineralogical
interpretation of spectra is sometimes confined to a particular range of OMAT values.
For example, topography with an OMAT value greater than 0.3 is sometimes accepted as
a threshold for the most reliable interpretation of spectra with minimal influence by the
maturation process.
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Fig. O-1
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Fig. O-2

Pyroxene has an absorption band near 1000 nm. Some types of basalt have a high olivine
content (up to 10 to 20 percent). The effect of high olivine levels is to broaden the
pyroxene band and to move it slightly towards higher wavelengths.
All rocks containing pyroxenes have bands between approximately 900 and 1000 nm.
Norite, which is comprised of plagioclase feldspar and low-Ca pyroxene, has an
absorption band between 900 and 930 nm. As the low-Ca pyroxene content increases, the
strength of the absorption band also increases. If an area of lunar rock has an absorption
band between 930 and 950 nm, it is probably noritic, but its pyroxene may have a higher
Ca content, or the norite may have some high-Ca pyroxene mixed in. Gabbro rocks are
very similar to basalts in mineral content, but gabbro rocks were formed
intrusively while basalts were formed extrusively.

Lunar gabbros tend to have a lower pyroxene content than lunar basalts. Lunar gabbros
can be almost pure high-Ca pyroxene, with an absorption band range of 970 to 1000 nm,
or they can be both high-Ca and low-Ca pyroxene, with an absorption band range of 950
to 970 nm.
Dunite and troctolite, two rocks composed of olivine, have absorption bands centered
beyond 1000 nm and often around 1100 nm when present in a purer form unmixed with
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other minerals. Dunite is almost pure olivine, while troctolite is made up of both
plagioclase feldspar and olivine. In both cases, the strength of the absorption band at
1100 nm depends on the level of olivine as compared to the level of plagioclase.
The 1-µm absorption band in olivines is due to a crystal field absorption of Fe2+. "Fo"
identifies forsterite (Mg2SiO4) in the forsterite-fayalite (Fe2SiO4) olivine solid solution
series. The Fo 29 sample (KI3291 from King and Ridley, 1987) has an FeO content of
53.65%, while the Fo 91 sample (GDS 71; labeled Twin Sisters Peak in King and Ridley,
1987) has an FeO content of 7.93%.

The identification of the olivine composition can be done with the comparison of spectra
collected from http://speclab.cr.usgs.gov/spectral.lib06/ds231/datatable.html

The 1000 nm band position varies from about 1080 nm at Fo 10 to about 1050 nm at Fo
91 (King and Ridley, 1987), corresponding to a FeO content >50 % or < 9% respectively.
This comparison is useful for identification of the ferroan type in the forsterite-fayalite
olivine solid solution series.

Pure anorthosite is composed almost entirely of plagioclase feldspar, and has no
absorption bands in the visible and near-infrared parts of the spectrum. But the term
anorthosite is used for lithologies that are at least 90 percent plagioclase feldspar and
containing up to ten percent mafic (i.e. iron containing) minerals.

The mafic component can be orthopyroxene, pyroxene, olivine, or a mixture of various
mafic elements. Anorthosite is a major component of the lunar crust, but areas of nearly
pure plagioclase feldspar (i.e. anorthite) with little or no mafic contamination are much
less common.

An illustration of the spectral differences, which in turn denote the chemical differences
between specific minerals, is shown in Fig. O-3.
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Fig. O-3: Example spectra of the Aristarchus region. Circles: pyroxene trough;
triangles: double trough (pyroxene and olivine); diamonds: single trough with
inflection feature (minor admixed olivine component); squares: olivine trough.

Figs. O-4 and O-5 show the diagrams with the UVVIS+NIR spectra of all Apollo
landing sites and the three Luna landing sites, respectively, from which samples
were brought back to Earth.

Fig. O-4 Apollo spectra. Red: Apollo 11; blue: Apollo 12; green: Apollo 14;
magenta: Apollo 15; cyan:Apollo 16; black: Apollo 17.

500 1000 1500 2000
0.8

0.85

0.9

0.95

1

1.05

wavelength [nm]

co
nt

in
uu

m
-r

e
m

ov
ed

re
fle

ct
a

nc
e

500 1000 1500 2000
0.8

0.85

0.9

0.95

1

1.05

wavelength [nm]

co
nt

in
uu

m
-r

em
ov

ed
re

fle
ct

a
nc

e



page 7

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY # 14

Fig. O-5 Luna spectra: Red: Luna 16; blue: Luna 20; black: Luna 24.

Methodology
Nine Clementine UV-visible and near infrared spectral bands covering the range from
415 nm to 2000 nm were downloaded in 16 bit TIFF format from the map-a-planet
website maintained by the USGS (see http://www.mapaplanet.org/explorer/moon.html ).
A geographic area was selected and the color albedo (i.e. natural color) image was
examined. The UV-visible bands 1 through 5 corresponding to 415 nm, 750 nm, 900 nm,
950 nm, and 1000 nm were requested individually in 16 bit tiff format. The database
was then changed to the near infrared enhanced color database without changing the
geographic location.
Near infrared bands 1 through 4 corresponding to 1100 nm, 1250 nm, 1500 nm 2000 nm
were then requested individually in 16 bit tiff format. The images were then converted to
image txt format using the Import function in ImageJ.
Periodically the PDSMAP website experiences problems with the downloading of 16 bit
tiff images, and if this occurs then it is also possible to use 16 bit raw images which have
also been completely pre-calibrated and are available on the PDSMAP website.

Subroutines were written for GNU Octave and for Microsoft Excel 2007 to extract
continuum divided absorption trough parameter data from this set of image txt files and
to apply an interpolation of the data points. This resulted in the automated production of
maps of a) the band center minimum and depth of the principal mafic absorption trough
near 1000 nm segregated into orthopyroxene (890-945 nm) and clinopyroxene (950-
1000nm) troughs; b) the band center minimum and depth of any secondary absorption
feature including both true troughs and curve inflections (i.e. “shoulders”) present at
higher wavelengths between 1005-1095 nm; and c) the FWHM width of the principal
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absorption feature.
The Microsoft Excel 2007 version employs a cubic spline interpolation
routine, while the GNU Octave version is based on an Akima interpolation
(Evans et al., 2009). Comparison of results showed no significant difference in band
center or band depth determinations, but there was a slight non-systematic variation in
FWHM widths in the results produced by the two program versions.

The automated spectral parameter mapping pursued in this paper results from a direct
method of algorithm based analysis of the continuum divided spectrum as described
above. A more detailed description of the Excel 2007 workbook used in the spectral
mapping process is provided in Appendix I of this paper.

Previous work by Le Mouelic (2000) and Lucey (1998) involved mapping of iron and
titanium content as well as the estimation of other spectral parameters including
continuum slope and mafic band depth. For those that are interested, maps modelled on
this work are presented in Appendix II. Appendix III contains several additional
examples of lunar feature spectral maps made in Excel.

Results
Aristarchus:

Fig. 1a
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Fig. 1b
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Fig 1c Ratio Map 2000nm/1500nm (olivine features appear bright)

Fig 1d
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Table 1e (Refer to Fig. 1d for locations A thru J)

Interpretation of Aristarchus Map Data:

Olivine is concentrated primarily in the area just beyond the crater rim to the southwest
although a very small focus of olivine rich terrain is also present just outside the crater
rim area to the southeast. The possibility that the olivine bcw and depth maps identify
impact melt rather than olivine is excluded by the 2000nm/1500nm ratio maps which
shows these foci as being bright. The remainder of the crater shows various
concentrations of clinopyroxene ranging from anorthositic gabbro to gabbro and
essentially no orthopyroxene is present. Olivine in mare material to the northwest of the
crater indicates the presence of basalt containing a moderate amount of olivine material.

Op bcw Op depth Cp bcw Cp depth Ol bcw Ol depth OMAT FWHM
A 0 0.0 1.0 0.195 1.026 0.197 0.413 279

B 0 0.0 0.99 0.133 1.005 0.117 0.365 222
C 0 0.0 0.97 0.18 0 0.0 0.419 265

D 0 0.0 0.98 0.152 0 0.0 0.442 246
E 0 0.0 1.0 0.130 1.005 0.056 0.487 208

F 0 0.0 0.98 0.150 1.005 0.077 0.416 262
G 0 0.0 1.0 0.1194 1.005 0.061 0.350 228

H 0 0.0 0.97 0.146 1.025 0.120 0.374 266
I 0 0.0 0.985 0.147 0 0.0 0.414 279

J 0 0.0 0.97 0.198 1.005 0.0379 0.438 226
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Bullialdus:
Fig. 2a
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Fig. 2b
Bullialdus Central Peak Area (Enlarged)
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Fig. 2c
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Fig. 2d

Table 2-e (Refer to Fig. 2d for locations of A thru F)

Interpretation of Bullialdus Map Data:

The central peak at location A is rich in orthopyroxenes but also contains some
clinopyroxene which is also identified in the remaining central peaks within the crater.
The crater rim is rich in clinopyroxenes and essentially no orthopyroxenes are identified
in the rim area.

Op bcw Op depth Cp bcw Cp depth Ol bcw Ol depth OMAT FWHM
A 0.930 0.195 0.950 0.218 0 0.0 0.383 203
B 0 0.0 0.980 0.107 0 0.0 0.249 204
C 0 0.0 0.985 0.129 0 0.0 0.235 204
D 0 0.0 0.980 0.141 0 0.0 0.270 200
E 0 0.0 0.960 0.081 0 0.0 0.219 210
F 0 0.0 0.950 0.062 1.021 0.035 0.218 247
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Copernicus:

Fig. 3a
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Fig. 3b
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Fig. 3c

Fig. 3d
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Fig. 3e (Refer to Fig. 3d for location of A thru I)

Interpretation of Copernicus Map Data:

The central peaks of Copernicus contain a significant amount of olivine (troctolite).

The fact that olivine rather than impact melt is identified by the olivine bcw and depth
maps is confirmed by the 2000nm/1500nm ratio map which shows the central peaks as
being bright.
The crater rim is mainly composed of various concentrations of clinopyroxenes, but the
main constituent appears to be gabbro although small foci of orthopyroxene and olivine
may also be present.

Op bcw Op depth Cp bcw Cp depth Ol bcw Ol depth OMAT FWHM
A 0 0.0 1.0 0.104 1.03 0.105 0.311 256
B 0 0.0 1.0 0.135 1.015 0.090 0.312 253
C 0 0.0 0.97 0.089 0.0 0.0 0.244 240
D 0 0.0 0.99 0.037 1.01 0.045 0.228 211
E 0 0.0 1.0 0.073 1.005 0.019 0.244 200
F 0 0.0 0.98 0.075 1.005 0.038 0.313 239
G 0 0.0 0.96 0.057 1.005 0.020 0.244 234
H 0 0.0 0.97 0.044 0.0 0.0 0.193 257
I 0 0.0 0.96 0.060 0.0 0.0 0.212 194
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Discussion:

This paper describes a fully automated process for the mapping of specific absorption
trough characteristics using Clementine UVVIS/NIR data. The band center minimum
and band depth near 1000 nm subdivided into orthopyroxene and clinopyroxene band
minima maps and maps of secondary troughs/shoulders at higher wavelengths, together
with the FWHM width are useful in lunar mineral characterization and optical maturity
maps (OMAT). Trough parameter maps were generated through the independent use of
GNU Octave and Microsoft Excel 2007. These maps provide a good indication of
mineral content over an extended geographic area. The Excel maps cover discrete
wavelength ranges typical for orthopyroxene, clinopyroxene and olivine content.
It should be noted that neither the band center nor the trough depth alone is sufficient to
interpret the local mineral composition. For example, a pixel representing an area with
an absorption band center at 1020 nm might represent ferroan anorthosite if the band
depth is below 5%, but might represent troctolite if the band depth is greater than 5%.
The FWHM value is also useful in interpretation since larger FWHM widths favor
impact melt or olivine content. The full range maps produced in GNU Octave and Excel
2007 are useful for a comprehensive interpretation of mineral content.

Editorial Note: Readers interested in working directly with a sample Excel
Workbook may request one from the Selenology Today Editorial Board.

Appendix I

A1-1 to A1-3 Screen shots of Excel 2007 workbook

Table A2-1 Maps created in worksheets 13 through 18

A3-1 Band center map

A3-2 Band depth map

A3-3 FWHM map

A3-4 False color map

Appendix II

A4.1 Aristarchus Image Group:
a Map of continuum slope
b Map of band depth
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c Map of band depth corrected for continuum slope
d Theta angle value map for titanium
e Map of titanium oxide
f Map of total iron wt %
g Map of total iron wt% as color gradient
h False color composite image of olivine deposits
i Absorption trough minimum map -Octave
j Absorption trough depth map - Octave
k FWHM map - Octave
l Key to geography of features in Table 4.1-1
m Clementine 9 band UVVIS-NIR spectra
n 5 band UVVIS spectra for olivine deposit
o 5 band UVVIS spectra for crater floor
p False color image of crater
q False color composite image of crater
r False color image of crater

(red: inv trough minima map, green: FWHM map, blue:
trough minima map). Topography: band depth map.

A4.2 Alphonsus Image Group:
a Map of continuum slope
b Map of band depth
c Map of band depth corrected for continuum slope
d Map of Theta for titanium
e Map of titanium oxide wt %
f Map of titanium oxide wt%, color gradient
g Map of total iron wt %
h Map of total iron wt %, color gradient
i Map of absorption trough minimum - Octave
j Map of absorption trough depth - Octave
k FWHM map - Octave
l Excel Maps
m Key to Geography of Table 4.2 – 1
n Clementine 5 band UVVIS spectra of Alphonsus Region
o Clementine 9 band UVVIS-NIR spectra of Alphonsus dark halo crater
p False color comosite map
q False color map (red: inverted absorption trough minima map, green:

FWHM map, blue: absorption trough minima map) Topography: band depth map

A4.3 Bullialdus Image Group:
a Map of continuum slope
b Map of band depth
c Map of band depth corrected for continuum slope
d Map of Theta for titanium
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e Map of titanium oxide wt %
f Map of titanium oxide wt %, color gradient
g Map of total iron wt %
h Map of total iron wt %, color gradient
i Absorption trough minimum map
j Absorption trough depth map
k FWHM map
l Key to geography of features in Table 4.5-1
m False color composite map
n False color map (red: inverted trough minima map, green:

FWHM map, blue: trough minima map). Topography: band depth map

Appendix III

A5.1 Excel Maps of Dionysius
A5.2 Orientation image of Dionysius
A5.3 Table of Values
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Appendix I: Description of Microsoft 2007 Mapping Workbook

Absorption trough minimum, band depth, OMAT and FWHM maps shown in the paper
were created using GNU Octave (http://www.gnu.org/software/octave/) or Microsoft
Excel 2007. Octave provides a rapid and efficient means of generating absorption trough
maps, but most amateur astronomers are probably unfamiliar with this program. On the
other hand, Excel is a commonly available and widely used program. Many if not most
amateur astronomers are probably familiar with Excel. Map creation can be performed
using Excel using a visual basic application (VBA) program with several subroutines, for
each map type, however it is necessary to expand the function library of Excel to include
a 3rd order spline fit function for data point interpolation and also a function to render a
curve segment as a polynomial equation. This is done by using the Add-in capability of
Excel as described below.

Excel workbook templates and required Excel function expansion “Add-ins”for
trough parameter mapping:
The Excel 2007 workbooks requires a free Excel add-in function library which is
available at no cost from xlxtrfun.com is available from: http://www.xlxtrfun.com/
XlXtrFun/XlXtrFun.htm. The spline function is added to the engineering function library
of Excel via a very simple procedure described at this link. It simply involves copying a
single .xll file to the XLSTART folder. A basic description of the method of map
generation is described below and a discussion of how to generalize the workbooks to
enable the calculation of maps of other lunar features is provided. The spline fit is used
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by all of the workbooks and is required for map creation. The workbook requires a
second Excel add-in function (trilookup) which is available at nominal cost from
www.trimill.com . It provides the best fit polynomial function to a curve segment and is
incorporated into the workbook in the same way.

Basic Worksheet Layout and Calculations:
The Excel 2007 workbooks input Clementine spectral maps between 415 nm and 2000
nm and output band center and band depth maps for orthopyroxenes (890 nm to 945 nm),
clinopyroxenes (950 nm to 1000 nm), olivines/impact melt features (1005 nm to 1095
nm), an optical maturity map (i.e. OMAT), and a FWHM map of the lunar feature of
interest. The clinopyroxene band center and band depth maps are created in worksheets
13 and 14 respectively. The olivine band center and band depth maps are created in
worksheets 16 and 17 respectively. The FWHM map is created in worksheet 15. The
OMAT map is created in worksheet 18. The orthopyroxene band depth and band center
maps are created in worksheets 19 and 20 respectively.

Loaded Clementine Data into the Workbooks:

- ImageJ used to prepare Clementine 9 band image sets for import into Excel
worksheets
Using the free program ImageJ (available here: http://rsbweb.nih.gov/ij/ ), Clementine
nine band image sets of any lunar geography can be cropped and converted to 32 bit txt
format for import into the Excel workbooks. If desired, image sets can be re-scaled in
Image J. This is done using the Image>Scale menu in ImageJ while working with an
imported image series (see below).
Cropped versions of the Clementine nine band data set in 16 bit tiff format (from 415 nm
to 2000 nm) are usually used because they require less time to calculate than uncropped
data. Clementine images are imported into ImageJ as an image sequence, the images are
cropped to best advantage, and the image sequence is saved as as individual 32 bit txt
files whose names preserve their wavelength band identity. To do this, the
Files>Import>Image Sequence menu is used to bring the Clementine 16 bit tiff image set
into ImageJ for cropping. The Clementine nine band image set in 16 bit tiff format
should be named according to band wavelength (i.e. 415.tif, 750.tif, 900.tif etc.). They
should be the only files present in the folder in which they reside. It is only necessary to
click on the first file in the Open Image Sequence menu to import the entire image
sequence. After simultaneous cropping of all images in the series by boxing the area
desired and applying the crop function (thus preserving their relative alignment to each
other), the resulting cropped image files are then resized if this is advantageous.
Resizing, if desired, is done using the Image>Scale menu in ImageJ. For example for
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Excel 2007 the pixel size could be set at 293 rows by 236 columns. The image series is
then saved as an image sequence using File>SaveAs>Image Sequence menu. Files must
be saved in 32 bit txt format with the individual file names preserved as the image slice
names. It is very important that the images be imported into the Excel worksheets 1
through 9 in the correct band order (i.e. 415, 750, 900, 950, 1000, 1100, 1250, 1500, and
2000 nm) with 415 nm in worksheet 1, the 750 nm image in worksheet 2, the 900 nm
image in worksheet 3 etc., until the 2000 nm image is copied to worksheet 9. All txt files
should be copied to worksheets starting at the row 1 and column 1 position.

Worksheet 10: The Calculating and Mapping Area of the Workbook
Worksheet 10 is the basic work and calculation area of the workbook. Mapping
calculations are done here and the absorption trough minimum map is created here. It is
essential that the total number of rows and columns be intered into cells L3 and L4
respectively of worksheet 10. The first 9 columns of worksheet 10 hold the Clementine
9 band data set for a single pixel per row. The data is sequentially located from 415 nm
to 2000 nm in columns A thru I respectively.
Columns M through S use formulas to calculate the continuum divided reflectance
spectrum where the continuum line is placed at 750 nm and 1500 nm, and the data set for
continuum division is provided by the same row of columns A thru I. Columns T, U and
V calculate the OMAT value for each map pixel. For the lunar feature of interest, the
continuum line divided results are loaded for all rows. As long as the total number of
rows and columns into cells L3 and L4 of worksheet 10 as described above, the program
will automatically initialize for a new data set that has been substituted into worksheets 1
through 9 in place of the loaded image set of interest. The usual continuum line is placed
at 750 nm and 1500 nm, but this can be varied if necessary. Occasionally it may be
advantageous to use a 750 nm to 2000 nm continuum line. The OMAT map is created in
worksheet 18. Worksheets 19 and 20 contain the orthopyroxene band depth and band
center maps respectively.

The maps are created either clicking on the Command Button present within worksheet
10 or alternately by pressing and holding the control key and pressing the f key. The
spectral parameter maps will be generated in image reverse column order in worksheets
13 through 18. The maps will take longer or shorter to create depending on the row by
column size of the data image set in worksheets 1 through 9. Finished maps can be
copied by selecting all map columns and using the Excel copy command. A finished txt
map generated in worksheet 13 through 18 can then be exported from Excel as an MS-
dos txt file. This is doing using the SaveAs command in the Excel menu. The finished
maps can then be imported into ImageJ as a txt image and can be examined and
horizontally reversed using the Image>Rotate menu in ImageJ.

Workbook Screenshots Explained:
Screen shots of Worksheet 10 are shown in the Figures below. For illustrative purposes,
the workbook shown in Figures A-1 through A-3 uses the 9 band Clementine UVVIS/
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NIR dataset for Copernicus. Note again that the total number of rows must be entered
into cell L3 and the total number of columns must be entered into cell L4 before
calculation of the map can begin. In Fig. A-1, the first Row shows wavelength
information. Clementine nine band data can be seen in Columns A through I, beginning
with Row 2 and continuing downward for other pixels in the same image column,
starting at Row 2 and continuing downwards. Continuum line calculations are present in
Columns J and K. Columns M through S show the continuum divided result for Columns
B through H. General information about the worksheet and the control button for
beginning map creation are shown in Column L. OMAT calculations for each map pixel
in the data column under analysis are shown in columns T through V.

Screen Shots of Excel Workbook for Absorption Trough Minima Calculation

Fig. A1-1

Fig. A1-2 shows a portion of the 105 data elements that extend from Column AA to
Column DC. These cells contain the cubic spline interpolation for the calculation of
specific wavelengths from 750 nm to 1500 nm. The range from 860 nm to 1250 nm is
covered in 5 nm increments. The wavelength is shown in Row 1 and the interpolated
trough value is shown in Row 2. The lowest value in Row 2 between AA and DC is the
overall trough minimum shown in Cell AA3. The reflectance value of the trough
minimum for orthopyroxene (890 nm to 945 nm) and clinopyroxene (950 to 1000 nm) is
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shown in Cells AA5 and AA6 respectively. Cell AA4 shows the value of any positive
slope to the curve between 1005 and 1095 nm which most closely approaches zero. This
latter method is designed to detect olivine “shoulders” or significant curve inflections
associated with olivine even if a well developed trough is not present.

Fig. A1-2

As shown in the graph in Fig. A-2 shows the absorption trough has a complex shape with
a shoulder present and is fitted to a 5th order polynomial in cells AH to AM.

Fig. A1-3

Spectral parameter maps are generated in worksheets 13 through 18 as follows:

Table A2.1 Maps generated within the worksheet

In strict terms the Sheet 13 maps the principal trough center present, but this is almost
invariably the pyroxene trough near 1000 nm. Sheet 16 maps the principal trough or

Sheet 13 Sheet 14 Sheet 15 Sheet 16 Sheet 17 Sheet 18
“Pyroxene”
band center
minimum

“Pyroxene”
band center
depth in per-
cent

FWHM “Olivine”
band center
minimum

“Olivine”
band center
depth in per-
cent

OMAT (optical
maturity)
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shoulder present beyond 1000 nm but under 1150 nm. For this reason pyroxene and
olivine are placed in quotation marks in Table A2-1.

Customizing the polynomial fit function (for very advanced users with a knowledge
of array functions and VBA programming):
Examples of routine maps automatically produced by the worksheet were shown earlier
in this paper. Figures A3-1 through A3-4 shows some custom generated maps for
Aristarchus produced by custom selecting a particular polynomial or spline fit to the
continuum divided absorption trough. These require minor program code alterations to
Macro 2 by the user, but are quite simple to achieve. Only a selected portion of the array
for the polynomial fit is shown in cells beginning at AC3 in Sheet 10.
This array is expandable to provide data for up to a 20 th order polynomial fit. In Figure
A3-1 the generated absorption trough minimum band center map generated by the Excel
program uses a 9th order polynomial fit.
Figure A3-2 shows the band depth map generated using a 3rd order (i.e. cubic) spline fit
to the Clementine absorption trough data. Figure A3-3 is the FWHM map generated
using a 5th order polynomial fit. Image A3-4 is a false color map of the crater created in
the CAD program Rhino. The band depth is represented by height. The color overlay
consists of the inverse of the trough minimum map in the red channel, the FWHM map in
the green channel, and the trough minimum map in the blue channel.

Fig. A3-1
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Fig. A3-2

Fig. A3-3



page 30

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY # 14

A3-4

Appendix II: Exploration of Spectral parameter estimation described by
LeMouelic (2000) and Lucey (1998)

The Clementine lunar probe imaged the lunar surface using five UV-visible spectral
bands and six near infrared bands covering the wavelength range from 415 nm to 2780
nm. The five UV-visible bands have been available on the map-a-planet website
maintained by the USGS for some years. Recently, however, the first four near infrared
bands covering the range from 1100 nm to 2000 nm have been calibrated so that both
datasets can be used seamlessly. Calibration for the last two near infrared bands (2600
nm and 2780 nm) is generally thought to be less reliable.
Examination of wavelength vs reflectance plots made from the 415 nm to 2000 nm
calibrated images provides important information about the mineral composition of the
moon. Information about the identity of iron bearing (mafic) minerals (pyroxenes and
olivine) is contained in the parameters of an absorption trough near 1000 nm. Most lunar
titanium is contained in the mineral ilmenite which absorbs near 415 nm. The 415 nm to
750 nm spectral ratio is proportional to the titanium content of lunar soils. Titanium
concentration can be calculated using this ratio. The continuum slope, generally taken as
the slope of a line connecting the reflectance value at 750 nm and 1500 nm, is steeper for
more mature (i.e. weathered) lunar features and shallower for more recent, less
weathered lunar features. This slope can be used to correct the depth of the mafic
absorption trough near 1000 nm for the effects of weathering by micrometeorite
bombardment and long term exposure to solar radiation. Weathering causes the
absorption trough to become shallower and less deep. The trough characteristics can be
restored by dividing reflectance values by the continuum slope. The total iron content of
a lunar feature can be calculated from the concentration of mafic minerals and ilmenite
(FeTiO3), since the latter contains iron as well as titanium. The total iron content of a
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lunar feature can be calculated from the slope corrected mafic trough depth and the
titanium concentration.

The specific equations (listed below) relating reflectance to the parameters discussed
above are discussed in great detail by Le Mouelic (2000) and by Lucey (1998). Rwavelength

refers to the pixel value of the Clementine image taken at that wavelength at the
particular location being measured. Eq. 4 below requires that R750 be in absolute
reflectance, which means that the pixel value must be multiplied by 0.000135.

(Eq. 1) Continuum Slope Determination

slope = (1/ R750) * (R1500 - R750)/(1.5 – 0.75) abs. refl./micron

This slope value is scaled to tangency at 0.75 microns

(Eq.2) Trough Depth Uncorrected for Continuum Slope

depth1= 1 – [(R950)/((2.2/3)R750 + (0.8/3)R1500))]

(Eq. 3) Trough Depth Corrected for Continuum Slope

FeOmafic = depth1 + 0.286 * slope

The slope calculated in Eq. 1 was scaled to tangency at 0.75 microns

(Eq. 4) Titanium Oxide content in wt. %

TiO2 = (Ti
2 * 20.79) – ((Ti * 22.928) + 5.909

(Eq. 4a) where: Ti = arc tan [((R415/R750) – 0.45) / (R750 – 0.05)]

and: R750 is in absolute reflectance (i.e. R750 * 0.000135)

(Eq. 5) Total Iron content in wt. %

total FeO = 45.6(depth1+ 0.286 * slope) – 3.8 + 0.9 TiO2

Nine Clementine UV-visible and near infrared spectral bands covering the range from
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415 nm to 2000 nm were downloaded in 16 bit TIFF format from the map-a-planet
website maintained by the USGS (see http://www.mapaplanet.org/explorer/moon.html ).
A geographic area was selected and the color albedo (i.e. natural color) image was
examined. The UV-visible bands 1 through 5 corresponding to 415 nm, 750 nm, 900 nm,
950 nm, and 1000 nm were requested individually in 16 bit tiff format. The database
was then changed to the near infrared enhanced color database without changing the
geographic location. Near infrared bands 1 through 4 corresponding to 1100 nm, 1250
nm, 1500 nm 2000 nm were then requested individually in 16 bit tiff format. The images
were then converted to image txt format using the Import function in ImageJ. These txt
images were processed using the Math and Image Calculator features under the Process
Menu of ImageJ such that the mathematical requirements of each one of the six
equations listed above was fulfilled by a single processed image constituting the spectral
image map for the parameter defined by the equation. However, ImageJ could not be
used to take the arc tangent as required by Eq. 4a and this was done by importing the txt
file into EXCEL 2007 and applying the arc tangent function in radians on a spreadsheet
containing the numerical matrix of the image. The processed image was then exported
from EXCEL 2007 as a txt file and imported into ImageJ for use in constructing the
spectral map corresponding to Eq. 4. At the conclusion of processing spectral map
images corresponding to the continuum slope, the trough depth uncorrected for slope, the
mafic trough depth corrected for continuum slope, the spectral angle Ti , TiO2 in wt. %,
and Total Iron in wt. % were produced for Aristarchus and Alphonsus.

A4.1 Aristarchus Area

The spectral data have been analyzed and the continuum slope scaled to tangency at 750
nm, the trough depth uncorrected, the mafic trough depth corrected for continuum this
slope, the spectral angle Ti , TiO2 in wt%, and Total Iron in wt% were produced in order
to assess their maturity and mineralogical composition. Figures A4.1a through A4.1h
were created using Eq. 1 through Eq. 5.
In the spectral map of continuum slope (Figure A4.1a) dark areas correspond to younger,
less weathered, regions (e.g part of central peak and east wall). Note that for the most
part the central peak is saturated so that it is not possible to carry out a specific analysis.
The process of surface maturation causes a reddening of the surface spectra (increase of a
positive slope) and a decrease of the spectral contrast of the absorption bands.
The spectral map of trough depth corrected for continuum slope (Fig A4.1c) obtained
from Fig A4.1b after correction for continuum slope scaled to tangency at 750 nm (Fig
A4.1a) displays the FeO mafic content. The SE wall regions and part of the central peak
shows lowest FeO mafic content in the Aristarchus crater.

A4.1a Spectral map of continuum slope
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Fig. A4.1b: Spectral map of trough depth uncorrected for continuum slope

Fig. A4.1c: Spectral map of trough depth corrected for continuum slope (FeO mafic
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content wt%)

Ilmenite is a Titanium oxide in varying abundance in the lunar maria and the maps of
Fig. A4.1e, produced by the inferred spectral angle Ti (Fig 1d) displays the inferred
TiO2 content in wt%. As expected from previous studies by Le Mouelic et al (2000) the
map shows a very low ilmenite content.

Fig. A4.1d: Map of spectral angle Ti

Fig. A4.1e: Spectral map of TiO2 in wt%
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The use of the equations (1-5), reported in the introduction, allow us to obtain the total
Iron in wt% (Fig 1f and the corresponding color gradient map shown in Fig. A4.1g),
discriminating highland type material (low-intermediate FeO content) and mafic material
(intermediate to high FeO content). The lowest FeO content is found in the unsaturated
portion of the central peak (4%) while the highest FeO content is detectable in the dark
mantle deposit covering the north eastern part of the ejecta material.

Fig. A4.1f: Spectral map of Total Iron in wt%

Figure A4.1g: color gradient map of Total Iron in wt %
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The presence of olivine is inferred from the color ratio mosaic image where the ratio
1250/1500 is assigned to the red channel, the ratio 1100/1500 to the green channel and
the ratio 2000/1500 to the blue channel. In the composite image the olivine deposit is
identified for the deep blue hue, while pyroxenes show bright yellow hue (Fig. 4.1h).

Figure A4.1h: color composite image, the olivine deposits identified for deep blue color
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This color ratio image discriminates between pyroxenes and olivine areas. In Fig. A4.1i
the band center for clinopyroxene, olivine and glass material is shown as bright white
regions, while the orthopyroxene (including noritic material) is dark. The Aristarchus
east floor displays band center in the range of 960 to 990 nm typical of high Ca
pyroxene (clinopyroxene).
Two olivine deposits (cfr. Fig A4.1h and A4.1i) are identified in the southeastern wall
and south wall at 4 and 6 o’clock respectively.

The absorption trough minimum values can be read from the band center estimation map
shown in Fig. A4.1 i below by the relation:
trough minimum [nm] = 925 + (200/255)*greyvalue.
In Fig. A4.1j the absorption trough depth values can be read from the calibration bar. In
Fig A4.1 k of the FWHM (full width at half maximum) map for Aristarchus, the FWHM
values can be read by the relation:
FWHM value [nm] = 150 + (300/255)*greyvalue.

Figure A4.1i: Absorption Trough Minima Map (i.e. Band Center Estimation Map)
created in Octave
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Fig. A4.1 j Absorption trough depth map created in Octave

Fig. A4.1k FWHM map
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The band center of the large olivine rich deposit, located on the SE wall, was measured
for a box area of 5X5 pixels. The absorption band was determined at 1047+/- 26 nm.
The second, smaller, deposit is recognized to the south, with an absorption band, for a
box of 3x3 pixel, centered at 1034 nm +/- 16 nm. The absorption band, for two
mentioned deposits, have a depth (uncorrected for maturity effect) of 0.185 +/- 0.029
and 0.119 +/0.013 respectively.
The corresponding FeO mafic, which is the trough depth corrected for continuum slope,
was computed as 0.247 +/- 0.024 wt % and 0.322 +/- 0.030 wt%.

The total Iron computed from the equation (1), and the map 1f, yield a content of 9.528
+/ 1.512 FeO wt% and of 7.984 +/ 0.593 FeO wt% respectively for two olivine rich
units. The inferred spectral results, if compared with the extracted spectra for a range of
terrestrial olivine samples, suggest the presence of a low ferroan, magnesian olivine. A
positive match was found with terrestrial sample Fo 91, for which the 1-µm band
position is centered at 1043 nm with a compositional analysis of FeO 7.93 wt %, MgO
50.70 wt% , SiO2 40.06 wt% , including very low amount of TiO2 of 0.14 wt%.

We have also assessed the shape of the five band spectra for two boxed areas
corresponding to the olivine rich unit (located to the southeastern wall) and to the central
west floor of Aristarchus (see Fig A4.1n, Fig. A4.1o and A4.1p).
The spectrum of examined olivine rich deposit (Fig. A4.1j) indicates a troctolite (T)
composition when compared with the predictive diagram by Tompkins and Pieters
(1999).

Fig. A4.1 l Key to Aristarchus Feature Locations for Table A4.1-1

Table A4.1-1
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Fig. A4.1 m

Crater Feature
(letter corre-
sponds to la-
belled image)

Total Iron in
wt% (note:
method not
valid for pyro-
plastic deposit
assessment)

Band Center
Estimate in
microns

Relative
Absorption
Depth %

% Depth
Uncorrected
for Slope

Continuum
Slope
scaled to
tangency at
750 nm

Area #1 11.2 .999 10.03 14.5 .242

Area #2 10.1 1.04 10.63 15.1 .460
Area #3 10.2 .998 5.63 10.1 .300

Area #4 9.4 .987 8.83 13.3 .300
Area #5 9.6 .973 11.33 15.8 .197

Area #6 9.9 .984 10.73 15.2 .269
Area #7 14.1 .974 10.53 15.0 .222

Central Peak ---- ------ 0 4.5 .091
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Fig. A4.1 n

The spectrum of examined olivine rich deposit indicates a troctolite composition.
The spectrum of examined area located on the west floor of the crater (Fig. A4.1l)
indicates a plausible anorthositic gabbro (AG) composition when compared with the
predictive diagram by Thompkins and Pieters (1999). The Clementine 5 band UVVIS
spectra of Area #2 is indicative of troctolite (Fig. A4.1 m) and the 9 band UVVIS-NIR
spectra are also consistent with this interpretation (Fig. A4.1 k).

Fig. A4.1o
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TITOLO DOCUMENTO

Figure A4.1p.

Accordingly, with the Fig. A4.1q, we have derived a false color mineral composition
map, where the areas of weak mafic concentration, that are primarily feldspathic, appear
pastel pink. The presence of a noritic component (intense red color) is excluded in
Aristarchus. In Fig. A4.1r, created using the CAD program Rhino, the band depth is
represented topographically as the height of lunar features while the false color overlay
has the inverted band center map in the red channel, the FWHM map in the green
channel, and the non-inverted band center map in the blue channel.

A4.1q Mineral mapping of Aristarchus Area

Fig. A4.1q
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Fig A4.1r

Inverse images were created using Photoshop CS2 using the
Image>>Adjustment>>Inverse menus.
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Mapping reveals several compositional units exposed within the crater, all being either
weakly mafic or gabbroic (Figure A4.1q). The generated map indicates that the western
floor and the western wall exposes mainly plagioclase likely with a small clinopyroxene
component (rusty orange). The same unit is located to the southwest around the two
localized olivine deposits (in bright green color). The shape of the extracted spectra,
compared with the model described by Tompkins and Pieters (1999), suggests an
anorthositic gabbro unit (AG), with a content of plagioclase of about 65%.
The rest of the crater appears to expose gabbroic units which appear blue in the color
map.

The southeastern wall and a small portion of the south wall reveal a more olivine-rich
unit, which is characterized for a troctolite composition. The inferred data in this work
reveal the presence of a magnesian olivine (MgO about 50%) with lower FeO content in
the forsterite (Mg2SiO4)-fayalite (Fe2SiO4) olivine solid solution series. The large bright
area above and to the right of the crater is artifactual.

A4.2 Alphonsus
With the same procedure described for Aristarchus we have analyzed the continuum
slope, the trough depth uncorrected for slope, the mafic trough depth corrected for
continuum slope, the spectral angle Ti , TiO2 in wt. %, and Total Iron in wt. % . Results
for a number of regional features are presented in Table A4.2 –1.

Figs. A4.2a and A4.2b show the spectral map of continuum slope scaled to tangency at
750 nm and the trough depth uncorrected for continuum slope. Fig. A4.2c shows the
spectral map of the trough depth corrected for continuum slope scaled to tangency at 750
nm. The DHC’s in Alphonsus have an unrealistically low total iron value as shown in
Fig. A4.2g and A4.2h. In Lucey (1998) it is stated that the iron mapping is not reliable
for pyroclastic deposits and that their measurement with the method should be avoided.
Figures A4.1i and A4.2j are maps of the absorption trough minima and absorption band
depth respectively. The values can be read from the greyscale as follows:
absorption trough minimum [nm] = 900 + (400/255)*greyvalue and absorption trough
band depth can be read from the calibration bar.

The FWHM width in nm can be read from Fig. A4.2k by the relation:
FWHM = 125 + (225/255) * greyvalue.
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Figure A4.2a: Spectral map of continuum slope scaled to tangency at 750 nm

Figure A4.2b: Spectral map of trough depth uncorrected for continuum slope
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Figure A4.2c: Spectral map of mafic trough depth corrected for continuum slope scaled
to tangency at 750 nm

Figure A4.2d: Map of spectral angle Ti
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Figure A4.2e: Spectral map of TiO2 in wt %

Figure A4.2f: Color map of TiO2 in wt %



page 49

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY # 14

Figure A4.2g: Spectral map of Total Iron in wt %

Figure A4.2h: Color gradient map of Total Iron in wt %
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Figure A4.2i: Alphonsus absorption trough minimum map:

A4.2 j: Alphonsus absorption trough depth map

Fig. A4.2. k FWHM map
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Fig. A4.2 l Excel Maps

Fig. A4.2 m Geographic Key to Table A4.2 - 1
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Table A4.2 - 1

Crater Feature
(letter corresponds
to labelled image)

Total Iron in
wt% (note:
method not
valid for pyro-
plastic deposit
assessment)

Band Center
Estimate in
microns

Relative
Absorption
Depth %

% Depth
Uncorrected
for Slope
(Eq. 2)

Continuum
Slope
scaled to
tangency at
750 nm

Floor of crater (F) 5.6 0.925 3.5 2.8 .503

Floor of crater (G) 6.4 0.935 1.9 4.1 .519

DHC West #1 (A) ------ 1.0 to 1.015 8.5 2.2 .306

DHC West #2 (B) ------ 1.010 to
1.040

8.0 1.8 .317

DHC East #1 (C) ------ 1.013 to
1.033

6.9 0.7 .320

DHC East #2 (D) ------ 1.019 to
1.040

11.0 0.9 .256

DHC East #3 (E) ------ 1.026 to
1.085

10.8 1.0 .160

NW Highlands (H) 6.0 0.895 to
0.945

5.9 3.8 .543

Central Peak (K) 7.0 0.890 to
0.925

0 1.5 .571

Mare Nubium #1
(I)

9.6 0.958 3.0 5.4 .386

Mare Nubium #2
(J)

10.3 0.960 2.0 3.8 .478
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Figure A4.2n Five Band UVVIS Spectra of Regional Features

Fig. A4.2o Alphonsus Dark Halo Material 9 Band UVVIS-NIR Spectra
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Figure A4.2 p: False Color Mineral Composition Map

The false color map in Fig. 4.2 p below has height controlled by the band depth map
while the false color overlay has the inverse of the band center map in the red channel,
the FWHM map in the green channel, and the band center map in the blue channel.

Fig. A4.2 q: False Color Topographic Map
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A4.3 Bullialdus

Using the same procedure described we have analyzed the continuum slope scaled to
tangency at 750 nm, the trough depth uncorrected for this slope, the mafic trough depth
corrected for this continuum slope, the spectral angle Ti , TiO2 in wt. %, and Total Iron
in wt. % . We also made a bc map and a band center estimation maps of Bullialdus as
well as false color images using the latter and the [2000/1500 nm] ratio image.
The central peaks are very noritic with deep mafic bands. The crater walls are gabbroic
but mixed with noritic material in some areas. Crater ejecta is gabbroic.

The absorption trough minimum map in Fig. 4.3i can be read by the relation:
trough minimum = 900 + greyscale value * 150/255.

The absorption trough depth map in Fig. 4.3j can be read from the calibration bar. The
FWHM width in nm can be read in Fig. 4.3k from the relation:
FWHM = 180 + (220/255) * greyscale value.

Fig. A4.3 a Map of Continuum Slope scaled to tangency at 750 nm
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Fig. A4.3 b Trough Depth Uncorrected for Continuum Slope

Fig. A4.3 c Mafic Depth Corrected for Continuum Slope scaled to tangency at 750 nm
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Fig. A4.3 d Theta Ti

Fig. A4.3 e Titanium Map Color Gradient
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Fig. A4.3 f

Fig. A4.3 g Total Iron
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Fig.A4.3 h Total Iron Color Gradient

Fig. A4.3 i Absorption Trough Minimum Map

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY # 14
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Fig. A4.3 j Absorption trough depth map
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Fig A4.3 k FWHM map of Bullialdus

Fig A4.3 l Key to Geographic Features in Table A4.5-1
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Table A4.3-1
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Fig. A4.3 m False Color Image
Red= Inverted Band Center; Green=2000/1500 nm; Blue=non-inverted Band Center

The false color map shown in Fig. A4.3 n below has height controlled by the band
depth map while the false color overlay has the inverse of the band center map in the red
channel, the FWHM map in the green channel, and the band center map in the blue
channel.

Fig. A4.3 n
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Appendix III: Additional Excel MapStudies

Dionysius

Fig. A 5.1
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Fig. A 5.2

Table A 5.3 (refer to Fig A 5.2 above for locations of A thru G)

Interpretation:

The crater wall of Dionysius contains prominent basaltic patches rich in olivine and
gabbro. These appear dark in the 1000 nm image. Other areas of the wall that appear
brighter in the 1000 nm image contain mixtures of orthopyroxene and clinopyroxene.
The proximal ejecta blanket of the crater shows a mixture of orthopyroxene,
clinopyroxene and olivine with the orthopyroxene component being relatively greater
than the other two components.

Op bcw Op depth Cp bcw Cp depth Ol bcw Ol depth OMAT FWHM
A 0.0 0.0 0.96 0.110 1.005 to 1.07 0.101 0.320 250
B 0.0 0.0 0.97 0.124 1.005 to 1.08 0.115 0.343 245
C 0.90 0.049 0.99 0.099 0.0 0.0 0.329 231
D 0.935 0.046 0.96 0.102 0.0 0.0 0.421 224
E 0.945 0.040 0.95 0.059 1.005 to 1.08 0.046 0.225 256
F 0.935 0.040 0.96 0.035 1.015 to 1.09 0.024 0.208 215
G 0.935 0.039 0.95 0.012 1.005 to 1.075 0.013 0.191 276
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Stevinus
Fig. 5.4
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Fig. 5.5

Table 5.6 (Refer to Fig. 5.5 for locations of A thru F)

Interpretation:
The central peaks of Stevinus are mainly gabbroic. The northeast rim of the crater shows
a prominent complex area of mixed orthopyroxene, clinopyroxene and olivine
composition.

Op bcw Op depth Cp bcw Cp
depth

Ol bcw Ol depth OMAT FWHM

A 0 0.0 0.97 0.188 0 0.0 0.458 245
B 0.935 0.060 0.97 0.085 1.02 0.0791 0.298 223
C 0.945 0.077 0.96 0.088 0 0.0 0.299 225
D 0 0.0 0.97 0.103 0 0.0 0.348 202
E 0.945 0.058 0.98 0.069 1.005 to 1.085 0.039 0.273 223
F 0.945 0.067 0.97 0.115 0 0.0 0.342 218
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Straight Wall

Fig. 5.7
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Fig. 5.7
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Table 5.8 (see Fig. 5.7 for location of A thru D)

Interpretation:

The Straight Wall does not differ in composition from the adjacent mare, but the slope is
less mature as seen in the OMAT map image. Consequently, the clinopyroxene and
olivine band depth is increased within the slope. This is most likely due to landslides
caused by occasional moonquakes since the slope has an inclination of about 20 degrees.

Op bcw Op depth Cp bcw Cp depth Ol bcw Ol depth OMAT FWHM
A 0 0.0 0.980 0.128 1.005 0.064 0.311 270
B 0 0.0 0.980 0.105 0 0.0 0.259 219
C 0.935 0.074 0.980 0.066 1.005 0.03 0.219 210
D 0.94 0.085 0.980 0.060 1.05 0.76 0.217 268


